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1. Introduction 

1) Background and objectives 

The EcoLogistics self-monitoring tool is developed through the “EcoLogistics: Low carbon freight for 
sustainable cities” project that is funded by the German Federal Ministry for the Environment, Nature 
Conservation and Nuclear Safety (BMU) through the International Climate Initiative (IKI). 
 
The tool can be utilized directly by cities to measure the existing greenhouse gas (GHG) emission 
performance of urban freight using CO2 equivalent (CO2e) values. It can also be used to estimate 
urban freight emissions in the business-as-usual scenario and allows the assessment of a target 
scenario wherein specific technologies or strategies that would improve fuel efficiency or reduce GHG 
emissions are hypothetically implemented. The tool allows cities to make meaningful comparisons 
over time and with other cities in terms of urban freight emissions.  
 
The self-monitoring tool is an open, Excel-based tool. This guide provides guidance on how to use the 
tool in connection to the databases and the most basic questions of emission calculations.  

2) What is calculated? 

The scope of the tool is limited to the calculation of emissions from urban freight transport 
operations. It includes road, rail and inland waterway freight transport. Other logistics activities may 
contribute additionally to overall freight emissions but are not addressed at this time and may be 
calculated in the future updates as new information or data becomes available.  
 
Carbon dioxide (CO2) is the most common GHG emitted and comprises the majority of emissions for 
freight and logistics activities, whereas carbon dioxide equivalent (CO2e) is a unit used to represent 
the global warming impact of various GHGs. Both are the standard references by which emissions are 
measured and are used throughout this document.   

3) What are the system boundaries for emission calculation? 

When accounting the GHG emissions of fuel used in freight vehicles, the tool includes emissions from 
the full life cycle, which are often referred to as well-to-wheel (WTW) emissions. WTW emissions are 
equivalent to the sum of indirect emissions known as well-to-tank (WTT) and direct emissions as 
tank-to-wheel (TTW) emissions. Figure 1 below illustrates the system boundaries considered under 
the self-monitoring tool.  

4) Which modes of transport are calculated? 

The following modes of transport calculated: 

 Road freight transport - Different types of road vehicles, aggregated into sizes, including 
electric and fuel-powered freight vehicles 

 Rail freight transport - Trains of different weights, including urban railway systems 

 Inland waterways freight transport - Different types of inland ships, including ferries, domestic 
inter-city vessels 
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Figure 1 System boundary and calculation approach considered under the tool 

 

5) How are emissions calculated?  

The calculation methodology behind the self-monitoring tool is consistent and is mainly based on the 
Global Protocol for Community-Scale Greenhouse Gas Emission Inventories (GPC)

1
 and Global 

Logistics Emissions Council Framework (GLEC Framework version 2.0)
2
. Generally, the methodologies 

for estimating transport emissions can be categorized as fuel-based and activity-based approaches.  

Fuel-based approach 

The fuel-based approach uses the fuel consumption data and converts fuel use into GHG emissions 
with defined emission factors. This method calculates emissions based on the amount of fuel sold 
within the city boundary. The data on the amount of fuel sold can be obtained from fuel dispensaries 
or fuel sales tax receipts. This approach uses the following equation: 
 
Equation 1 Fuel-based approach for emission calculation 

 

                                                           
 
1
 World Resources Institute, C40 Cities Climate Leadership Group, ICLEI – Local Governments for Sustainability 

(ICLEI), Global Protocol for Community-Scale Greenhouse Gas Emission Inventories (GPC). (2014). 
2
 Smart Freight Centre. Global Logistics Emissions Council Framework for Logistics Emissions accounting and 

Reporting. (2019). Retrieved from https://www.smartfreightcentre.org/en/how-to-implement-items/what-is-glec-
framework/58/ 

CO2 emissions = 
∑ (quantity of fuel consumed (liters) × emission factor for the fuel (e.g., kg CO2e/liter) 
+ 
sum across grid regions: 
∑ (quantity of electricity consumed (kWh) × emission factor for electricity grid (e.g., kg CO2e/kWh)) 
 
Description Value 

Total CO2e emissions in tons Computed 

Quantity of fuel consumed in liters, gallons or kilograms User input 

Emission factor for the fuel (e.g., kg CO2e/liter, or kg CO2e/gallon) Default data  

Emission factor for electricity grid (e.g., kg CO2e/kWh) Default data  
 
Source: GPC 
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If fuel data is not available, users may calculate the quantities of fuel consumed from fuel spend or 
from the distance travelled. 

Activity-based approach 

If access to fuel consumption data is limited or incomplete, a calculation using the activity-based 
approach may be recommended. This approach seeks to quantify emissions within the city, including 
the trips that begin, end, or within the city. This requires information on vehicle kilometers travelled 
(VKT) for each vehicle type, vehicle occupancy, information on vehicle fuel efficiency or emission 
intensity factors, which are applied in multiple steps. The component variables can be disaggregated. 
The approach uses the equation as follows: 
 
Equation 2 Activity-based approach for emission calculation 

 

6) Main factors on emission calculation  

The energy consumption and emissions of freight transport depend on a wide array of factors.  
Each transport mode has unique properties and conditions. Thus it is important to calculate 
emissions separately for each mode. The following parameters are of general importance for all 
modes of transport: 

 Vehicle/ train/ vessel type, size and weight 

 Load factor is the ratio of the shipment weight to the payload capacity of a vehicle or vessel. 
The amount of CO2e estimated in the tool is sensitive to load factors.  

 Transport distance travelled (kilometers, km) 

 Tonne-kilometer (abbreviated as t-km, also written as tonne-km, tonne.km or tkm in table and 
formulae), refers to the transport of one ton of goods over a distance of one kilometer. To 
evaluate freight transport activities, it is essential to consider both the weight of the shipment 
and the distance the cargo is transported. As such, t-km is useful to express efficiency for 
freight transport in a consistent manner. Note that for some commodity types, it would be 
more appropriate to measure freight movement in terms of volume rather than weight.  

 Fuel consumption, expressed as liters per 100 kilometers (L/100 km), refer to the amount of 
fuel the vehicle needs to travel a certain distance. In general, the lower the value, the more 
economic a vehicle is. Fleet-wide fuel consumption rates depend on an array of factors: 
freight vehicle mix, fuel mix of freight vehicle stock, vehicle age, distance travelled, average 
speed and congestion level etc. They can typically be derived by dividing total fuel use by total 
kilometers. 

 The emission factor of the energy source (including solid and liquid fuels and electricity), i.e., 
the amount of CO2e emitted per unit of fuel used. It is important to be sure about the fuel type 
to choose the appropriate fuel emission factor.  

Sum across transport modes and/or vehicle types: 
∑ (mass of goods transported (tons) 
× distance travelled (kilometers) 
× emission factor of transport mode or vehicle type (e.g., kg CO2e/tonne-kilometer) 
 
Description Value 

Total CO2e emissions in tons Computed 

Mass of goods transported in tons Default data provided in 
Error! Reference source not 
ound. 

Distance travelled in kilometers User input 

Emission intensity factor in kg CO2e/t-km Default data 

Electricity emission factor(e.g., kg CO2e/kWh) Default data  
 
Source: GPC 
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7) Which default data is used? 

The self-monitoring tool provides default data or setting for calculation. The default emission factors 
are sourced from the GLEC Framework, which is based on average freight transport operating 
practices and provides a general indication of fuel consumption and emissions. The GLEC Framework 
is aligned with global efforts on carbon accounting for logistics operations, including the 
Intergovernmental Panel on Climate Change (IPCC) Guidelines for National Greenhouse Gas 
Inventories, among others. The global warming potential values are drawn from the IPCC 2007 report.  
 
In general, standard values for load factor and empty running are embedded within the default factors.  
However, users should use values that are representative of the specific freight operations in the city, 
reflecting the characteristics of their urban freight transport.  

2. Application modes 
This section introduces the input modes of the tool calculation front-end and the underlying 
parameters. Before you start, it is important to know:  

 This tool works best using Microsoft Excel 2007 and up. Features might be lost if previous 
versions or Microsoft Excel for Mac are used.  

 In any of the worksheets, users must only change or add values to the yellow and white cells. 

 In any of the worksheets, you can go back to the homepage by clicking the home icon at the 
upper right corner of the sheet. 

 
The tool provides a standardized interface and comprises of the following tabs: 

1. Home (excel sheet tab is colored green) 
2. City profile (tab is colored green) 
3. Mode of transport (tabs are colored green) 

 Road freight transport  

 Rail freight transport  

 Inland waterways transport  
4. Forecast (tab is colored green, the following tabs are colored grey) 

 Fuel technology change  

 Distance reduction  

 Eco-driving  

 Off-hour deliveries (also known as “out of hours” deliveries) 
5. Results (tab is colored green) 

 
Several worksheets are hidden, which contain back-end calculations and lists of default parameters. 
You can display hidden worksheets as needed by following the steps: On the Home tab, in the Cells 
group, click Format > Visibility > Hide & Unhide > Unhide Sheet. You'll be presented with a dialog box 
listing the sheets that are hidden, and you can select the one you want to unhide. 
 
To start your calculation, you can follow the steps below: 
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Figure 2 Steps in emission calculation and projection 

 

1) Home tab 

The “Home” tab contains the introduction of the EcoLogistics self-monitoring tool and provides an 
overview of the functionalities. As illustrated in Figure 3 below, each icon on the home tab redirects 
users to its respective tab: “City profile”, “Road transport”, “Rail transport”, “Inland waterway transport” 
and “Results”. “Impact assessment” button redirects users to a list of pre-defined solutions that would 
potentially reduce the environmental impact of urban freight transport.  
 
Figure 3 Interface of “Home” tab 

 

 

2) City profile tab 

The city profile tab is designed to highlight the freight characteristics and transport activities in the 
urban contexts, along with dimensions of city size, geographic location and demographics. It also 
outlines the air quality index (AQI) and key pollutants, which is used for monitoring air pollution.  
 
The yellow cells indicate that they are mandatory input cells, while the white cells suggest that they 
are optional. It should be noted that the data items on this tab are common to all cities and they 
contribute to the existing body of knowledge on urban freight transport. However, they are not key 
parameters for emission calculation. Many cities may have trouble finding reliable information about 
freight transport activities or tons of goods lifted for journeys within, to, through and from the city. As 
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efforts to improve data accuracy continue to expand, users may move forward to other tabs for 
emission calculation.  
 
Figure 4 Interface of “City profile” tab 

  

City properties  

 City: Fill in your city name 

 Country: Fill in your country name 

 Region: Choose from a dropdown menu of the following regions: Africa; East Asia; Europe; 
Latin America & Caribbean; North Africa, Middle East and West Asia; North America; Oceania; 
South Asia; Southeast Asia. It should be noted that uplifted values will be applied to emission 
intensity factors for local conditions in Asia and Africa. For a detailed explanation please refer 
to the road section. 

 Climate: Fill in the climate type as per Köppen climate classification, one of the most widely 
used climate classification systems, e.g., Rosario, Argentina has a Pampean, humid 
subtropical climate (Cfa/Cwa). In contrast, Bogotá, Colombia has a subtropical highland 
climate (Köppen Cfb).  

 Area: Measured in square kilometer (km
2
) 

 Boundaries: Choose between geographic or administrative boundaries. Any geographic 
boundary may be used to understand where emissions are coming from and to indicate 
where it can take action or influence change. In some cases, the boundary can align with the 
administrative border of a local government, a metropolitan area, or another geographically 
identifiable entity (GPC). 

City parameters 

In the city parameters section, most of the data items vary over the modeled years. 
 

1) Socio-economic data 

 Year: You can fill in the base year and the modelled years in this section, e.g., if the data is 
collected from 2019, this will be the base year which your city’s emissions are tracked and 
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compared over time, as well as the base year for impact assessment and emission 
projections.  

 Population: Historical and forecast population data in terms of thousand (k) 

 Gross Domestic Product (GDP): Historical and forecast GDP defined in terms of million 
dollars (USD) 

 Population growth rate (%): Annual population growth rate  
 

2) Transport data – further divided into heavy goods vehicles (HGV, with a gross vehicle weight of 
3.5 tons or more) and light goods vehicles (LGV, with a GVW up to and including 3.5 tons) 

 Number of registered vehicles: Number of vehicles registered within the city in terms of 
thousand  

 Annual vehicle registration growth rate: Percentage of vehicles/year 

 Total urban freight (within): The number of goods transported within the city 

 Total urban freight (From): The number of goods transported from within the city boundary to 
outside the city boundary  

 Total urban freight (To): The number of goods transported from outside the city to the city 

 Total urban freight (Through): The number of goods transported in the trips that pass through 
the city, with both origin and destination outside the city 

 

3) Total emission reduction target – Target of emission reductions from air, road, rail and inland 
waterway transport, expressed in percentage (%) of ton/year 

Air quality data 

On-road diesel vehicles accounted for 60 percent of transportation-attributable fine particulate matter 
(PM2.5) in the EU and were responsible for nearly half of the health impacts of air pollution from 
vehicles worldwide in 2015

3
. Targeting emissions from on-road diesel vehicles could generate 

substantial benefits for public health because these vehicles account for such a high proportion of 
the city’s transportation attributable to deaths from air pollution. Thus, this section is included. 
 
Air Quality Index (AQI) is an internationally uniform index for reporting and forecasting daily air quality. 
It is divided into six categories and it uses a normalized scale from 0 to 500. The color-coded Table 1 
below shows how the AQI values correlate with different levels of health concern and cautionary 
statements, developed by the United States Environmental Protection Agency (EPA). Users may 
search for city air pollution levels from existing platforms, such as the World Health Organization 
(WHO)'s Global Platform on Air Quality and Health

4
. 

 
Table 1 The Air Quality Index, levels of health concerns and cautionary statements 

Index 
values 

Levels of health 
concern 

Cautionary statements 

0 - 50 Good None 

51 - 100 Moderate Unusually sensitive people should consider reducing prolonged or 
heavy exertion outdoors. 

101 - 150 Unhealthy for 
sensitive groups 

Active children and adults, and people with lung disease, such as 
asthma, should reduce prolonged or heavy exertion outdoors. 

151 - 200 Unhealthy Active children and adults, and people with lung disease, such as 
asthma, should avoid prolonged or heavy exertion outdoors. Everyone 
else, especially children, should reduce prolonged or heavy exertion 
outdoors. 

                                                           
 
3
 International Council on Clean Transportation. A Global Snapshot of The Air Pollution-Related Health Impacts of 

Transportation Sector Emissions in 2010 and 2015. (2019). Retrieved from 
https://theicct.org/publications/health-impacts-transport-emissions-2010-2015 
4
 The Global Platform on Air Quality and Health combines ground station monitoring with satellite data for a 

comprehensive view of air pollution levels in over 4000 cities. Retrieved from https://breathelife2030.org/the-
issue/air-quality-in-your-city/ 
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201 - 300 Very unhealthy Active children and adults, and people with lung disease, such as 
asthma, should avoid all outdoors exertion.  Everyone else, especially 
children, should reduce prolonged or heavy exertion outdoors. 

301 - 500 Hazardous Everyone should avoid all physical activity outdoors. 

 
The concentration levels of key air pollutants are required in the section. WHO recommends guideline 
values for each type of pollutant. Details can be found on its website

5
.  

 
Table 2 Data inputs in the AQI section  

Air pollutants Description Unit WHO guideline values 

Fine particulate matter 
(PM2.5) 

Particles  with a 
diameter of 2.5 microns 
or less 

Micrograms 
per cubic 
meter (μg/m

3
) 

10 μg/m
3
 annual mean;  

25 μg/m
3
 24-hour mean 

Particulate matter (PM10) Particles  with a 
diameter of 10 microns 
or less 

μg/m
3
 20 μg/m

3
 annual mean;  

50 μg/m
3
 24-hour mean 

Nitrogen dioxide (NO2) A main source of nitrate 
aerosols 

μg/m
3
 40 μg/m

3 
annual mean;  

200 μg/m
3
 1-hour mean 

Ozone (O3) Ozone at ground level μg/m
3
 100 μg/m

3
 8-hour mean 

Carbon monoxide (CO) A colorless, odorless 
and flammable gas 

μg/m
3
  

Sulphur dioxide (SO2) A colorless gas with a 
sharp odor 

μg/m
3
 20 μg/m

3
 24-hour mean; 

500 μg/m
3
 10-minute mean 

Number of days exceeding 
AQI standards 

AQI values at/ below 100 
are generally thought of 
as satisfactory 

Days/year  

Minimum/maximum daily 
average concentration 

 μg/m
3
  

Annual average 
concentration 

 μg/m
3
  

3) Input mode for all transport modes  

In the input mode for each mode of transport, users only need to enter data into the yellow cells, 
which are the key parameters for emission calculation. The white cells in the tabs indicate that they 
are input cells and may improve the granularity of the data.  
 
Default values are provided in the self-monitoring tool, however, users must note these values are 
placeholders and are subject to high uncertainties. Please also note that the load factors will be fixed 
and greyed out when users check the “NA” box. In such case, each of these values is based on a 
particular set of assumptions. This may lead to results that over- or underestimate emissions 
compared with actual conditions. Figure 5 below illustrates the interface of the road transport tab, 
required inputs and corresponding outputs.  

                                                           
 
5
 World Health Organization Air Quality Guidelines. (2019). Retrieved from https://www.who.int/news-room/fact-

sheets/detail/ambient-(outdoor)-air-quality-and-health 
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Figure 5 Interface of “Road transport” tab 

 
 
The following functions are common to all transport modes (road, rail and inland waterways).  Users 
can edit the input data. Click on the yellow/white fields and the parameters can either be edited or 
chosen from dropdown lists.  
 
“Calculate” 
Calculate the emissions. Users are highly recommended to click on the calculate button once all the 
yellow fields are filled out. The tool provides an on-screen report which includes the GHG emissions in 
terms of CO2 and CO2e. However, users must note that results may not be available and will be greyed 
out where critical parameters for emission calculation are not available. Guidance is provided in the 
following sections on how to deliver the best output from the information available.  
 
“Insert” 
Insert the data. Click on the insert button and the data is stored locally in the excel spreadsheet. Note 
that if the parameter exists already in the database, a dialogue box is opened and the users can 
choose to update the field.  
 
“Delete” 
Delete the data. The data is removed from the tool.  
 
“Show” 
Show the data that is stored in the database. Click on the show button and a dialogue window is 
opened. Users can select a record and it will be reflected in the corresponding field. 
  
Numerical input and rounding 
Decimal notation can be used and it is denoted with a period, e.g., 1.234. Any numerical input is 
considered to be a rounded value – rounded to 2 digits.  

4) Forecast tab 

The “Forecast” tab comprises of “impact assessment” section and “action assessment” section. In 
the input mode, users need to enter the data in the yellow fields. The values will be automatically 
generated in the orange fields.  Figure 6 illustrates the interface of this tab. 
 
A limited set of socio-economic and vehicle technology variables are forecast through to 2050.  

 Base year refers to the specific year against which a city’s emissions are tracked over time. It 
corresponds to the first year filled out in the City profile tab. 
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 Growth rate: To forecast road transport emissions, the demand for new road freight activity is 
one of the most uncertain variables in the emission reduction analysis. Details on how to 
predict can be found in the Forecasting emissions section. 

 
Figure 6 Interface of “Forecast” tab 

 

Impact assessment 

Running the “Impact assessment” involves the following steps: 

1. Load the input data onto the “Impact assessment” section. The base year emissions from 
road freight transport are calculated automatically. 

2. Using the expected transport growth rate, which is based on additional historical data series, 
including GDP, population, among others, the future emissions for 2025, 2030 and 2050 are 
projected. 

Action assessment 

Each of the measures listed in “Forecast” tab have their spreadsheets in the tool. Figure 7 below 
depicts the inputs in the “Fuel technology change” assessment. The yellow cells in the scenario 
sheets are input cells. For most of the scenarios, several basic parameters are required: 

 Base year: It corresponds to the first year filled out in the City profile tab 

 Forecast year: by default it is 2050 

 Vehicle type: Choose the road freight vehicle type in the dropdown list; the vehicle type and its 
respective fuel type should be entered in the road transport before the assessment 

 Temperature condition: Whether it is refrigerated or not 

 Road freight transport growth rate: It corresponds to the “Freight growth rate (%)” in the 
Forecast tab 

 Fuel technology used: Choose the fuel type in the dropdown list; the fuel used and its 
respective vehicle type should be entered in the road transport tab/ database 

 Uplifted values: The current default values for road transport used in the tool are for North 
America, Europe and South America. For road freight vehicles in Asia and Africa, uplifted 
values are applied to the regional values for Europe and South America. 

 
The following input fields need to be filled out in the scenarios where specific technologies or 
strategies that would reduce CO2e emissions are implemented: 

 Fuel technology to use: This parameter is required in the “Fuel technology change” tab. 

 Distance reduction rate (%): This parameter is required in the “Distance reduction” tab. 



    

ICLEI EcoLogistics Self-Monitoring Tool User Guide Short Version (Version 2.0)                                                            11 

 

 Eco-driving fuel saving rate (%): This parameter is required in the “Eco-driving” tab. 

 Off-hour periods: This parameter is required in the “Off-hour delivery” tab. 
 
Running the “Action assessment” involves the following steps: 

1. Load the above mentioned basic parameters onto the tab. The base year emissions from the 
selected vehicle/fuel type are calculated, based on the vehicle activity data entered previously 
in the road transport tab/ database. 

2. Using the expected freight transport growth rate, the tool forecasts the million km and million 
t-km for the year 2050. The CO2 e emissions in the Business-as-usual (BAU) scenario are 
calculated. BAU scenario describes future emission levels on the assumption that no 
additional policies or actions to reduce emissions are adopted. 

3. Assuming the million km and million t-km remain the same for the target scenario, the tool 
calculates the resulting CO2e emissions using the corresponding fuel emission factors. The 
target scenario represents future emissions with the assumption of the introduction of 
specific policies and measures targeting GHG emission reductions. 

4. The emissions in the target scenarios are then compared to those of the BAU scenario to see 
the potential emission reductions. 

 
Figure 7 Interface of “Fuel technology change” tab 

 

5) Results tab 

The "Results" tab contains summary data of the city and its socio-economic data. It also includes a 
series of illustrative graphs of the following data: 

 Estimated emissions from the road, rail and inland waterways transport for the base year, 
expressed as million tons 

 Estimated emissions (million tons) and freight transport activities (million ton-kilometer, t-km) 
by each mode of transport over the modelled years 

 Four types of freight trips, including through, to, from, within. The results are transferred from 
the City profile tab.  

 Share of emissions by vehicle/ train/ vessel type for base year 

 Share of emissions by fuel type for each mode of transport 
 
Figure 8 below illustrates the interface of the results tab.  
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Figure 8 Interface of “Results” tab 

 

 

3. Road transport  
On-road transport contributes significantly to the global transport emissions. Freight transport by road 
is expected to grow. Currently, the vast majority of road freight vehicles burn liquid or gaseous fuel in 
internal combustion engines, which produces CO2, CH4 and N2O, often referred to as tailpipe 
emissions. Increasingly, electrification of short-distance freight vehicles is becoming a viable option.  
 
On-road freight vehicles are designed to transport goods on public roads or highways. This category 
includes vehicles such as motorcycles, trucks, and waste collection vehicles.  Emissions from road 
transport refer to the fuel or electricity used to operate road freight vehicles, and exclude the 
emissions related to the production of vehicles or road infrastructure. Table 3 below shows the 
requirements for the estimation of road transport emissions.  
 
Table 3 Parameters for road transport emission calculation 

Parameter Description Unit 

Year of assessment Select the modelled year, e.g., 2019; Base year 
corresponds to the first year filled out in City profile tab 

  

Gross vehicle weight 
(GVW) 

Select the type of vehicle  Ton (t) 

Load factor Load factors make a significant impact on energy use and 
emissions. Standard values for empty running and load 
factors are embedded within the default emission 
intensity factors for different types of vehicles. 

Percentage (%) 

Total distance Actual distance should be inputted if available. In general, 
only vehicle operators have access to actual distance 
travelled. Cities can seek carriers and logistics companies 
for the activity data; when a sampling survey is used, 
cities can scale up the activity data to the city-scale.  

Million km  

Ton-kilometer  
(t-km) 

The tool uses the following equation: 
t-km = Payload capacity (t) x Load factor (%) x Total 
distance (km) 

Million t-km 

Fuel type The calculation depends on the fuel type. Most on-road 
freight vehicles burn diesel or gasoline, while other 
potential types include electricity, CNG, LNG, LPG, 
biomethane, and bio LNG. 

 

Unit Fuel use is usually reported using mass (kg) as the unit; In 
practice, liquid fuels are measured by volume (liters or 
gallons). In the dropdown-list, users can select the 
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preferred unit to specify fuel consumption. The data can 
be provided in the following units: 
Diesel: kg, liters, gallons 
Gasoline: kg, liters, gallons 
LPG: kg, liters, gallons 
CNG: kg 
LNG: kg 
Electricity: kilowatt-hours (kWh) 
Biomethane: kg 
Bio LNG: kg 

Fuel consumption Fuel consumption figures, expressed as liters per 100 
kilometers (L/100 km), refer to the amount of fuel the 
vehicle needs to travel a certain distance. In general, the 
lower the value, the more economic a vehicle is. Fleet-
wide fuel consumption rates depend on an array of 
factors: freight vehicle mix, fuel mix of freight vehicle 
stock, vehicle age, distance travelled, average speed and 
congestion level etc. They can typically be derived by 
dividing total fuel use by total kilometers.  

Liter/100km, 
gallon/100km, 
kg/100km or 
kWh/100km, 
depending on 
the fuel type, 
but this is 
automatically 
selected. 

Electricity EF When users select electricity as the energy type, additional 
information about emission intensity of electricity 
generation (g CO2e/kWh) is required. In the dropdown list, 
the following values are provided: 

 In regions where coal-based electricity generation 
is commonplace: 850 g CO2e/kWh 

 Fossil-based: 500 g CO2e/kWh 

 Average EU: 320 g CO2e/kWh 

 On the way to renewable energy: 200 g CO2e/kWh  

 Largely decarbonized: 30 g CO2e/kWh 

 Not applicable: A dialogue box is presented, 
asking users to select the energy source for its 
electricity generation.  

 Others*: A default value of 160 g CO2e/kWh is 
provided, however it must be noted that the value 
is only a placeholder and users need to enter the 
value in the “Electricity EF” hidden worksheet. To 
unhide the worksheet, you can follow the steps: 
On the Home tab, in the Cells group, click 
Format > Visibility > Hide & Unhide > Unhide 
Sheet. You'll be presented with a dialog box listing 
the sheets that are hidden, so select the 
“Electricity EF” and enter the value there.  

 
*While some countries publish their own electricity 
emission factors

6
, there is no guarantee that they are 

calculated on the same basis. Therefore the emissions 
per kWh should be used with caution and the databases 
should be updated regularly. For users who have little 
knowledge of their national electricity emission factors, 
the figures above are a suitable starting point. 
 
It should also be noted that the values are only applicable 
to vans (up to 3.5 t), rigid trucks (3.5 t - 7.5 t GVW) and 

 

                                                           
 
6
 Available sources can be found here: 

https://www.carbonfootprint.com/docs/2019_06_emissions_factors_sources_for_2019_electricity.pdf 
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rigid trucks (7.5 t- 12 t GVW), as well as rail transport 
where the locomotive uses electricity as its energy source. 

Type of trip flow 
(optional) 

Select between within, through, to, from   

Type of goods 
(optional) 

Select between average, bulk and volume goods 
 

  

Refrigerated (optional) Temperature controlled or not, when users choose 
“refrigerated”, for vans (up to 3.5 t GVW), a 15% uplift will 
be applied to the values presented in Error! Reference 
ource not found.; For heavier vehicles (> 3.5 t GVW) a 12% 
uplift will be applied. 

  

Number of vehicles 
(optional) 

Many vehicle registration databases do not deregister 
vehicles that are scrapped or out of service. This might 
give higher emission factors to the calculation. 

Thousand (k) 

Age of vehicles 
(optional) 

Select between 0 – 5, 5 – 10, 10 – 15, Over 15 or Not 
applicable. 

  

4. Rail transport  
It is estimated that approximately 7 percent of global freight transport activity (in terms of tonnekm) 
were shipped by rail in 2015, which contributed to 4 percent of the GHG emissions from the 
transportation sector

7
. Railways are powered by locomotives, which typically use energy through the 

combustion of diesel or electricity. Previous studies indicate that CO2 emissions per t-km are 
significantly lower for electric traction.  
 
The parameters affecting rail transport emission calculation is listed in Table 4 below. The estimate 
should be based on actual operating data, if not publicly available datasets.  
  
Table 4 Parameters for rail transport emission calculation 

Parameter Description Unit 

Year Select the year for assessment in the dropdown-list  

Train type Train types can be divided into general cargo types (average, bulk 
and volume goods) and dedicated cargo types (container, cars, 
chemistry etc.).  

 

Load factor For rail transport, there is no well-established load factor. Existing 
tools estimate the load factor based on net and gross ton-
kilometers for the above-mentioned cargo types.  

Percentage (%) 

Total distance The actual rail network distance should be used in the calculation. 
In practice, rail distance can be hard to find, but some existing 
tools can be useful, for instance, EcoTransIT’s online tool

8
. 

km 

t-km Similar to other transport modes, t-km is the key unit for rail 
transport, representing one ton of cargo moving for one kilometer.  
Actual or estimated shipment weight based on the mass of cargo 
should be used to calculate t-km, if available. 

Million t-km 

Type of 
traction 

Diesel and electricity are the most common fuel types for rail 
transport. Cities should obtain fuel consumption data from railway 
operators by fuel type. Where detailed activity data are 
unavailable, cities can use queries or surveys to calculate the fuel 
use and amount of goods transported, scale down regional or 
national fuel consumption based on city population or other 

Liters or 
gallons for 
diesel, Kwh for 
electricity  
 

                                                           
 
7
 International Energy Agency & International Union of Railways. Railway Handbook 2017: Energy Consumption 

and CO2 Emissions. (2017). Retrieved from https://uic.org/IMG/pdf/handbook_iea-uic_2017_web3.pdf 
8
 See more https://www.ecotransit.org/calculation.en.html 

https://uic.org/IMG/pdf/handbook_iea-uic_2017_web3.pdf
https://www.ecotransit.org/calculation.en.html
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indicators.  

Fuel 
consumption 

Depending on the fuel type, fuel consumption estimates for rail 
freight vary widely. 

Liters/100km, 
gallons/100km 
or kWh/100km 

Electricity EF Similar to the road transport tab, when the locomotive uses 
electricity as its energy source, additional information about 
emission intensity of electricity generation is required,  
Please refer to Table 3 for data input requirements. 

 

Number of 
wagons 
(optional) 

The tool assumes a default number of wagons (20) when using 
the activity-based approach.  

 

5. Inland waterways transport  
Freight transport by inland waterways transport comprises a relatively small share of the urban freight 
sector. Water transportation includes ships, ferries and boats operating within the city boundary. The 
emissions from inland waterways refer to the movement of cargo along stretches of water.  The 
parameters affecting inland waterway transport emission calculations are summarized below.  
 
Table 5 Calculation parameters for inland waterway transport emission  

Parameter Description Unit 

Year Choose the year for assessment in the dropdown-list  

Vessel type Select type of vessel. The tool suggests using the above-
mentioned vessel classes (incl. typical payload of a 
representative vessel belonging to that vessel class), however, 
it is acknowledged that a wide range of vessel types and sizes 
can be distinguished depending on the country and region, 
e.g., in the US and South America the preferred vessels used 
for inland navigation are largely pushed convoys. 

 

Load factor Average load factors for the above-mentioned vessel types 
are used; Generally, it is in the range of 45 - 75 percent, 
depending on vessel types.  
If the load factor is known to be different from the 
representatives incorporated in the default values, cities 
should work to obtain a fuel efficiency value that reflects the 
actual conditions.  

Percentage (%) 

Total distance Actual waterway network distance should be used, based on 
the origin and destination of the freight trip. For instance, data 
from the vessel log book.  

km 

t-km A consistent approach to calculating weight, distance and t-
km is required to streamline data sharing and improve the 
accuracy of results.  
Actual shipment weight should be used, if available. Cities can 
obtain data using official records of surveys to determine the 
weight of cargo. 

 

Fuel type Marine diesel fuel is the assumed fuel type for inland water 
transport. Cities can seek this data from shipping companies 
and fuel suppliers. 

  

Fuel 
consumption 

Provide information on the fuel consumption in terms of 
liters/ 100km or gallons/ 100km. 

Liters/100km or 
gallons/100km 

Type of trip flow 
(optional) 

Specify the type of freight trip  

Type of goods 
(optional) 

Specify cargo type that is transported by representative 
vessel: Bulk/ Containers/ Pallets/ Mass-limited/ Volume-
limited, when unknown, choose not applicable 

 

Number of Specify the number of vessels per vessel class registered in Thousand (k) 



    

ICLEI EcoLogistics Self-Monitoring Tool User Guide Short Version (Version 2.0)                                                            16 

 

vessels 
(optional) 

the city 

Age of vessels 
(optional) 

  

6. Forecasting emissions 
In the self-monitoring tool, collected data can be used to determine current emissions. Analysis can 
also be used to project future emissions under circumstances that may happen without intervention, 
which is often called business-as-usual (BAU). The measurement of current freight movement data 
serves as the basis for the BAU calculation, which must then be projected into the future for ex-ante 
analysis or ex-post analysis. Besides, the tool estimates target scenarios where specific policies or 
strategies are hypothetically implemented by the city. The target scenario considers additional 
measures which allow the freight transport sector to deviate from the BAU emission trajectory.  
Figure 9 depicts how emission reductions are calculated for each of the scenarios. 
 
Figure 9 Estimation of potential emission reductions  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The target scenario considers different measures in 
isolation as determined based on local development 
priorities, feasibility, costs and benefits assessment, 

including: “Fuel technology change”, “Distance reduction”, “Eco-driving” and “Off-hour deliveries”. 

1) Fuel technology change 

Fuel technology change refers to adopting technologies that promote high efficiency and alternative 
fuels, such as biofuels, CNG, LNG. These actions are intended to cut overall GHG emissions by 
reducing the use of carbon-intensive fuels. The reduced carbon intensity of the new fuels can be from 
reduced upstream emissions. The required input data is listed as follows: 
 
Table 6 Parameters for fuel technology change projection  

Parameter Description Unit 

Base year The base year corresponds to the first year filled out in the City profile 
tab 

  

Forecast year By default the forecast year is 2050   

Vehicle type Select vehicle type. It should be noted that the vehicle type and its fuel 
type should be entered in the road transport tab/ database before the 
impact assessment.  

  

Refrigerated Specify whether the vehicle is refrigerated or not   
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Road freight 
transport 
growth rate 

The rate corresponds to the growth rate filled out in the forecast tab. A 
default value of 3 percent is provided in the tool, using the estimated 
global freight demand growth rate. However, it must be noted that the 
value is only a placeholder and may not reflect actual conditions. It is 
recommended that users apply more locally-suited numbers, if available. 

Percent
age (%) 

Fuel 
technology 
used 

Current fuel type, which serves as the basis for the base year’s emission 
calculation. Similar to the vehicle type input field above, the fuel type 
should be entered in the road transport tab/ database before the impact 
assessment. 
 
A default corresponding emission intensity factor is provided based on 
the vehicle type and fuel type. See Error! Reference source not found. 
or more details. When users select electricity as the energy type, an 
additional input is required, i.e. electricity emission factors.  
 
Please refer to Table 3 for data input requirements and Error! Reference 
ource not found. for more information about electricity emission 
factors.  

 

Fuel 
technology to 
use 

Forecast change in fuel type. Same as above, a default value of 
emission intensity factor is automatically selected, if applicable.  
It should be noted that in the following scenarios, a dialogue window is 
opened, indicating that the calculation for selected option is not 
available and the results are unlikely to be accurate: 

 LGV (< 3.5 t): Switching from diesel to gasoline  

 Rigid truck (12 - 20 t): Switching from diesel to LNG 

 Rigid truck (> 20 t): Switching from diesel to LNG  

 Truck and trailer (> 20 t): Switching from diesel to LNG  

 

Uplift value to 
use in Asia and 
Africa 

In line with the GLEC Framework, the tool recommends the emission 
intensity values for road vehicles (European and South American values) 
as a starting point. In Asia and Africa an uplifted value of 13% should be 
applied for light goods vehicles (< 3.5 t) and an uplifted value of 22% 
should be applied for heavier vehicles (> 3.5 t). 

Percent
age (%) 

 
To calculate the GHG emissions in the target scenario, the tool assumes the million km and million t-
km remain the same as those in the BAU scenario. Broadly speaking, each scenario discussed below 
is based on a particular set of assumptions and the results are unlikely to be highly accurate. However, 
it may be considered as a suitable starting point where there is limited access to data or little detailed 
knowledge.  

2) Distance reduction  

To calculate the impact of distance reduction on GHG emissions, we assume the fuel type used 
remains the same but million km and million t-km are reduced according to the parameter “Distance 
reduction (%)”. Other parameters are the same as those in Table 6. 

3) Eco-driving 

Eco-driving is based on a series of techniques that drivers can adapt to reduce fuel consumption and 
GHG emissions. This includes reducing the use of air conditioning, minimizing engine idling, 
maintaining steady speed, avoiding sharp acceleration and braking. Additional non-behavioral 
measures include regular vehicle maintenance.  
 
The input parameters are similar to those in Table 7. For the parameter “Eco-driving fuel saving rate”, 
we assume an average value of 10 percent based on existing studies. However, the extent to which 
drivers commit to eco-driving behavior is a major uncertainty factor. The results are highly variable in 
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terms of context: vehicle type, road type, traffic flow and so on
9
. Table 7 describes the fuel savings 

from eco-driving program.  
 
In this tool, fuel savings are assumed to be equivalent to emission savings, which is commonly used 
by other studies looking at CO2 effects. While this would be true in percentage terms, the absolute 
emission reduction from fuel saving would vary according to the fuel being used. Assuming km and t-
km remain the same values in the BAU scenario, the resulting emissions are calculated by multiplying 
the BAU emissions with (1 - Eco-driving fuel saving rate). 
 
Table 7 Fuel savings from eco-driving 

Urban networks  Fuel saving 
rate (%) 

Remarks 

Mixed roads  Average 10%  Only limited benefits for HGVs as driving dynamics are 
constrained by the traffic volume and road layout 

Junctions, traffic lights, 
bends 

Up to 25% Eco-driving can save up to 25% of CO2 for HGVs in very 
localised situations 

Congested situations 
and motorways 

0% Little or no CO2 benefit 

Source: “ITS4CV” – ITS for Commercial Vehicles. Study of the scope of Intelligent Transport Systems 
for reducing CO2 emissions and increasing safety of heavy goods vehicles, buses and coaches. (2016). 
Retrieved from http://erticonetwork.com/wp-content/uploads/2016/09/ITS4CV-Report-final-2016-09-
09.pdf 

4) Off-hour deliveries 

Off-hour deliveries (OHD) focus on shifting freight deliveries from peak period to off hour period to 
improve safety and reduce congestion and emissions 
 
A large body of research on OHD assessed the environmental impacts and the potential emission 
reductions attributable to the implementation of OHD program. The magnitude of the emission 
reductions depends on the extent of the change of delivery time. Table 8 below indicates that OHD 
reduces emission by 13 to 56 percent compared to deliveries during regular hours in similar routes.  
 
Table 8 Emission reductions from off-hour deliveries  

Off-hour periods Description Emission reduction rate (%) 

19.00 – 6.00 Late night and early morning 
periods (Full OHD) 

Average 56% (45% - 67%) 

18.00 – 22.00 Partial off-hour (Partial OHD) Average 13% 

6.00 – 19.00 Regular hours 0% 

Source: Holguín-Veras, José & Encarnación, Trilce & Gonzalez-Calderon, Carlos & Winebrake, James & 
Wang, Cara & Kyle, Sofia & Herazo-Padilla, Nilson & Kalahasthi, Lokesh & Adarme, Wilson & Cantillo, 
Victor & Yoshizaki, Hugo & Garrido, Rodrigo. (2016). Direct impacts of off-hour deliveries on urban 
freight emissions. Transportation Research Part D: Transport and Environment.  

 

                                                           
 
9
 Recent study on freight transport operations in Colombia show that after the eco-driving campaign, an average 

reduction of 6.8 percent is obtained when fuel consumption is measured in terms of liters per ton-100 km.  


